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This section discusses each of the twelve
MUSIC LESSONS I drills. We’ll begin by
looking at elements common to all twelve
drills. Information presented in this
opening section will not be repeated later.
When we discuss the individual drills
we’ll focus on elements unique to that
drill.

USER SETTINGS
The way you interact with MUSIC
LESSONS I is affected by settings in the
Preferences dialog, and by items in the
Options, Sound, Clefs, Instrument, and
Level menus which will be discussed
briefly here. A more thorough discussion
will be found in the Menus and Prefer-
ences sections of this manual.

Many settings in MUSIC LESSONS I can
be made permanent so they’ll be remem-
bered the next time you use the program.

A setting is on when the item is checked;
it’s off when there is no check. Items that
end with an ellipsis (...) open a dialog box
with additional choices. Items that are
grayed out are disabled and cannot be
chosen.

OPTIONS MENU
Items in the Options menu affect how you
input answers and interact with the
program.

Auto Next Note
When Auto Next Note is on and you play
a note, the text insertion point advances to
the next answer box. When Auto Next
Note is off and you play a note, the text
insertion point remains in the same
answer box. To advance to the next
answer box type the tab key. The menu
item affects only the current drill. To
make this setting permanent use the Drill
page of the Preferences dialog. See page
31.

Auto Next Question
If Auto Next Question is on when you
check your answers and your answer is
correct, you’ll get a new question. The
menu item affects only the current drill.
To make this setting permanent use the
Drill page of the Preferences dialog. See
page 31.

Allow Typed Answers
If Allow Typed Answers is on, you can
type your answers. When Allowed Typed
Answers is on, MUSIC LESSONS I
doesn’t care if you play the note in the
correct octave, only that you get the name
right. This menu item affects all twelve
drills. To make this setting permanent use
the General page of the Preferences
dialog. See page 30.

Fast Answer Checking
When Fast Answer Checking is on,
MUSIC LESSONS I automatically checks

CHAPTER 1 - DRILLS
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your answers as soon as all answer boxes
are filled. If your answers are correct
you’ll instantly get a new question. If any
answers are wrong, the first wrong answer
will be selected. When you’ve corrected
that answer, the next wrong answer will
be selected. As soon as you’ve corrected
all the wrong answers, your answer will
be checked again. Fast Answer Checking
is a rapid way to improve your skills in all
drills. This menu item affects all twelve
drills. To make this setting permanent use
the General page of the Preferences
dialog. See page 30.

Set Global Keys
Set Global Keys lets you choose the keys
or starting notes used when assigning
questions. The menu item affects the Key
Signatures, Major Minor Scales, Modes,
Jazz Scales, Scale Degrees, and Intervals
drills.

SOUND MENU
Items in the Sound menu let you choose
whether to use Mac, QuickTime, or MIDI.
You can also use sound effects, change
the tempo, and assign MIDI patches. See
Chapter 4, Sound, page 39.

CLEFS MENU
The items in the Clefs menu let you
choose between treble, bass, alto, tenor, or
a combination of these clefs. The clef you
select affects all drills.

INSTRUMENT MENU
The items in the Instrument menu let you
choose between a Piano, Guitar, or
Alphabet Blocks instrument. The
instrument you choose affects all
instrument drills.

LEVEL MENU
The Level menu for each drill is divided
into two sections, main and custom. The

menu items in the main section of each
drill will be discussed later in this section.
The items in the custom section of the
Level menu are the same for each drill.

You can create, save, and load up to four
custom levels in each drill.

Set Custom Levels
When you choose the Set Custom Levels
command, a dialog box opens where you
can create the content for four custom
levels. Although the Set Custom Levels
dialog boxes are different for different
drills, they all share some common
features. For example, let’s look at the Set
Custom Levels dialog box for the Scale
Degrees drill.

Several types of controls are used in the
dialog: buttons, radio buttons, and check
boxes. Groups of controls enclosed in
rectangular frames are called clusters.

Buttons
There are slight variations in the appear-
ance of the buttons in this dialog. The
default button (OK) is outlined by a thick
black border. You can type return or enter
as a shortcut for the default button. A
button whose name ends with an ellipsis
(Set Clef…) opens another dialog box
with additional settings. Buttons that are
grayed out (<<Prev) are disabled and
cannot be chosen.
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Radio Buttons
Radio buttons are used for multiple choic
items. In any group of radio buttons, only
one radio button can be on at a time.

Check Boxes
Check boxes differ from radio buttons in
that several check boxes can be on at one
time. Custom dialogs often contain many
check boxes. It’s tedious to turn them on
and off one at a time, so we’ve made it
easier. The buttons All On and All Off
will turn every checkbox in the dialog on
or off. Clicking the cluster title will turn
every check box in that cluster on and off.

Set Custom 1 Name
The title of this button indicates which of
the four custom levels you’re working
with. Clicking this button opens the Set
Custom Name dialog where you name
this custom level. That name will appear
in the Level menu.

<< Prev and Next>>
Use the Prev and Next buttons to navigate
through the four custom levels. The level
currently in effect is shown in the Set
Custom 1 Name button title.

Save Custom Levels
The Save Custom Levels menu command
is used to save the four custom levels of
the current drill. You can create as many
custom level files, for as many drills, as
you want. Each file contains one set of
custom levels for one drill.

Load Custom Levels
The Load Custom Levels command is
used to open a custom level file. The
standard open file dialog will appear.
After you’ve selected the custom level file
you want to open, another dialog will ask
for confirmation prior to replacing the
custom levels.

If you click Load, the custom levels found
in the file replace the four custom levels
of that drill.

Dim Unused Selections
Another setting that affects custom levels
is the Dim Unused Selections check box
found on the Drill page of the Preferences
dialog. It affects the display of answer
buttons in the Custom Levels you create
in the six multiple choice drills: Key
Signatures, Scale Degrees, Intervals, Note
Rest Durations, Scales Ear Training, and
Intervals Ear Training. When the Dim
Unused Selections check box is off, all
answer buttons are enabled, even though
only a few may have been used for the
questions. When the Dim Unused
Selections check box is off, only those
answer buttons that are actually used are
enabled; the others are disabled.

Here’s an Intervals Ear Training custom
level that uses only major and minor
seconds and thirds.

Dim Unused Selections On

Dim Unused Selections Off
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The topics we’ve just covered are
common to all twelve drills. We’ll now
discuss the drills individually, focusing on
elements unique to each drill.

 NOTE READING

The purpose of this drill is to help you
learn to read music and improve your
sight reading. Sight reading is one of the
most important musical skills you can
develop, because the better you are at
sight reading, the more music you can
play. The Note Reading drill is an
excellent way to improve your sight
reading skills, especially when used with
Fast Answer Checking.

Note Reading Skill Levels

There are five main levels. The level in
effect will have a check mark by its name.

 Spaces — Notes appear on the four
spaces of the staff.

 Lines — Notes appear on the five lines
of the staff.

 Staff — Notes appear within the staff.
 Ledgers — Notes appear within the

staff and on ledger lines above and
below the staff.

Ledgers Only — Notes appear only
above and below the staff.

The following items modify the current
skill level. A check mark in the menu
indicates that it’s in effect.

No Accidentals — Notes appear without
accidentals.

Single Accidentals — Notes appear with
sharps, flats, or naturals.

Double Accidentals — Notes appear
with sharps, flats, naturals, double
sharps, or double flats.

The following items modify the Ledgers
and Ledgers Only drills and are enabled
only when you’re using those two levels.
A check mark in the menu indicates that
it’s in effect.

Beginning Ledgers — Notes appear up
to two ledger lines above or below the
staff.

Advanced Ledgers — Notes appear up
to five ledger lines above or below the
staff.

Notes will not exceed the range of the
displayed instrument. For example, the
highest note you can play on the four
octave piano in treble clef is two ledger
lines above the staff. However, if you
switch to the six octave piano, notes five
ledger lines above the staff will be within
the range of the instrument and therefore
can be used.

Note Reading Custom Levels
The Set Custom Levels command from
the Level menu opens the Custom Levels
dialog where you can create four custom
levels for the Note Reading drill.

Clef — Choose the clef.
Accidentals — Choose the accidentals.
Range Bounds — Choose the minimum

and maximum note range.
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 CIRCLE OF FIFTHS

The purpose of this drill is to help you
learn how the Circle of Fifths is used to
identify major and minor keys based on
the number of increasing sharps and flats
found in the key signature, the order that
sharps and flats appear in key signatures,
and the ability to play through the
ascending or descending circle of fifths
beginning with any note. Circle of fifths
motion is used extensively in jazz, pop,
and classical music chord progressions.

Circle of Fifths Skill Levels

There are seven main levels. The level in
effect will have a check mark by its name.

Major Sharp Keys — the major sharp
keys in order of increasing sharps in
the key signature, from C major to Cz

major C-G-D-A-E-B-Fz-Cz

Major Flat Keys — the major flat keys
in order of increasing flats in the key
signature, from C major to Cx major
C-F-Bx-Ex-Ax-Dx-Gx-Cx

Minor Sharp Keys — the minor sharp
keys in order of increasing sharps in the
key signature, from A minor to Az minor
A-E-B-Fz-Cz-Gz-Dz-Az

Minor Flat Keys — the minor flat keys
in order of increasing flats in the key
signature, from A minor to Ax minor
A-D-G-C-F-Bx-Ex-Ax

Order of Sharps — the order that sharps
appear in the key signature Fz-Cz-Gz-Dz-
Az-Ez-Bz

Order of Flats — the order that flats
appear in the key signature Bx-Ex-Ax-
Dx-Gx-Cx-Fx

Random Keys — name notes moving
through the ascending or descending
circle of fifths beginning with
randomly selected starting notes

The following items affect the way the
drill window is drawn. �A check mark in
the menu indicates that it’s in effect.

Show Staff — display notes on the music
staff

Show Circle — display notes around the
circle

Circle of Fifths Custom Levels
The Set Custom Levels command from
the Level menu opens the Custom Levels
dialog where you can create up to four
custom levels for the Circle of Fifths drill.

Direction — Choose either ascending or
descending direction. For example, C-
G-D-A-etc. moves by ascending fifths
and C-F-Bx-Ex-etc. moves by
descending fifths.

View — Choose the music staff view or
circle view.

Set Clef — Choose the clef. The clef in
effect for this custom level is
displayed to the right of the button.

Starting Keys — Choose the keys you
want to use for the questions.
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 KEY SIGNATURES

This drill will help you learn to identify
major or minor keys based on the number
of sharps or flats appearing in the key
signature. Key signatures appear just after
the clef symbol on each line of music.
When you know the key signature and the
notes of the corresponding major or minor
scale, you know the notes the composer
used as the raw materials for the melodies
and harmonies in the piece.

Key Signatures Skill Levels

There are three main levels. The level in
effect will have a check mark by its name.
You can specify the keys you want to use
with the Set Global Keys command in the
Options menu. See page 62.

Major — Major keys will be used.
Minor — Minor keys will be used.
Major and Minor — Major and minor

keys will be used.
If you choose either Major or Minor, only
one set of answer buttons will be drawn.
If you choose both Major and Minor, both
sets of answer buttons will be drawn.

The following items modify the current
skill level. A check mark in the menu
indicates that it’s in effect.

Sharp Keys — Key signatures use
sharps.

Flat Keys — Key signatures use flats.
Sharp and Flat Keys — Key signatures

use both sharps and flats.

Key Signatures Custom Levels
The Set Custom Levels command from
the Level menu opens the Custom Levels
dialog where you can create up to four
custom levels for the Key Signature drill.

Types — Choose major keys, minor
keys, or both.

Major Keys — Choose the major keys
you want to use.

Minor Keys — Choose the minor keys
you want to use.

Set Clef — Choose the clef. The clef in
effect for this custom level is
displayed to the right of the button.

 FIVE FINGER

POSITIONS
This drill will help you learn to recognize
and play the five finger positions of all
major and minor keys. Five finger
positions are used in the early years of
piano lessons. Because five finger
positions use the first five notes of the
major and minor scale, they are a good
introduction to scales. The Five Finger
Position drill is most useful with the piano
instrument and is less useful with the
guitar and alphabet block instruments.
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Five Finger Positions Skill Levels

There are four main levels. The level in
effect will have a check mark by its name.

Major — All fifteen major keys will be
used.

Minor — All fifteen minor keys will be
used.

Major and Minor — All major and
minor keys will be used.

Key Groups — Select major and minor
keys from four groups.
• Group 1 — Fingers 1 3 5 on white
keys

• Group 2 — Fingers 1 and 5 on white
keys, 3 on a black key
• Group 3 — Fingers 1 and 5 on black
keys, 3 on a white key
• Group 4 — The rest

The following items modify the current
skill level. A check mark in the menu
indicates that it’s in effect.

Ascending Motion — The five notes will
be displayed in ascending order.

Descending Motion — The five notes
will be displayed in descending order.

Ascending and Descending — The five
notes will be displayed in either
ascending or descending order.

Random Motion — The five notes will
be displayed in random order.

The following items modify the current
skill level. A check mark in the menu

indicates that it’s in effect.

Beginning Register — The five notes
will be placed in commonly used
music staff positions.

Advanced Register — The five notes
will be placed in commonly used staff
positions as well as an octave higher
or lower.

Use Key Signatures — If this is checked,
a key signature appears in the staff
and the notes appear without acciden-
tals. If it’s unchecked, no key
signature is displayed and the notes
appear with accidentals.

Use Hints — If this is checked, a light
bulb button is displayed to the left of
the screen piano. When you click the
light bulb, the piano keys for that five
finger position will be highlighted.
This item is not available with the
guitar or alphabet block instruments.

When the light bulb button is visible you
can type “Command-I” as a shortcut for
clicking the light bulb.

Five Finger Positions Custom
Levels
The Set Custom Levels command from
the Level menu opens the Custom Levels
dialog where you can create up to four
custom levels for the Five Finger Position
drill.

Major Keys — Choose any combination
of major keys.

Minor Keys — Choose any combination
of minor keys.
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Placement — Choose the placement of
the notes on the staff.

Motion — Select Ascending, Descend-
ing, Ascending and Descending, or
Random motion.

Set Clef — Choose the clef. The clef
currently in effect is displayed to the
right of the button.

Use Key Signatures — If this is checked,
a key signature appears in the staff
and the notes appear without acciden-
tals. If it’s unchecked, no key
signature is displayed and the notes
appear with accidentals.

Use Hints — This displays the light bulb
button to the left of the screen piano.
You can click the light bulb to
highlight the piano keys used for the
five finger position.

THE THREE SCALES
DRILLS
The Major/Minor Scales, Modes, and Jazz
Scales drills have these elements in
common: the Strict Answers and Lenient
Answers menu items; the Black Keys Are
Sharps and Black Keys Are Flats radio
buttons; the Accidental Toolbar; and the
keyboard popup menu. Each of these
items affect the spelling of the names of
notes.

STRICT / LENIENT
ANSWERS
These two items are found in the Level
menu. Because every note can have three
enharmonic names (C = Bz = Dxx) it’s
sometimes difficult for MUSIC LES-
SONS I to know what to call the notes
you play. In music theory the correct
spelling of each note is important. Strict
Answers enforces music theory rules for
the names of notes in the scale. Lenient
Answers relaxes the rules so you can just
play the notes on the keyboard.

Strict Answers
If Strict Answers in the level menu is
checked, the following items affect the
names of the notes you play: the keyboard
popup menu, the Accidental Toolbar, the
Black Keys Are Sharps, and the Black
Keys Are Flats radio buttons.

Keyboard Popup Menu
Click a piano key, guitar fret, or alphabet
block and keep the mouse button held
down. A popup menu will appear allowing
you to select the name of the note.

Accidental Toolbar
When you need to apply a specific
accidental to a note, select it here before
playing the note. There are command key
shortcuts for each of the accidentals. Press
the “Apple-clover leaf-propeller” key and
type the letter shown.

Black Keys Are Sharps Button and
Black Keys Are Flats Button
When the Natural is selected in the
Accidental Toolbar, these two buttons are
automatically set to the most common
accidental used in the scale. Notes you
play will be correct about 95% of the
time, but you still will have to use the
keyboard popup menu or Accidental
Toolbar for special cases like calling a
white key Ez instead of F.

The following charts show how the
accidental selected in the Accidental
toolbar affects the names of the notes in
Strict Answers mode.

White Key Names
White key names are not affected by the
Black Keys Are Sharps or Black Keys Are
Flats radio buttons. They are affected by
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the accidental selected in the Accidental
Toolbar as shown in the following chart.
Notes that do not make sense with the
selected accidental are shown as a double
question mark.

Black Key Names
If the natural is selected in the Accidental
Toolbar, the black key names reflect the
setting of the Black Keys Are Sharps or
Black Keys Are Flats radio buttons. If an
accidental other than the natural is
selected in the Accidental Toolbar, the
names of black keys are shown in the
following chart. Notes that do not make
sense with the selected accidental are
shown as a double question mark.

Lenient Answers
In the Lenient Answers mode, if you play
a correct note it will be named correctly.
If you play a wrong note the following
rules apply.

White Key Names
White keys are named by their natural
name.

Black Key Names
Black keys are named from the most
common accidental used in that scale.

 MAJOR / MINOR

SCALES
This drill will help you learn what notes
are used in the major, natural minor,
harmonic minor, and melodic minor
scales. The notes of these scales are the
raw materials used to construct melodies
and chords.

Major/Minor Scales Skill Levels

There are five main levels. The level in
effect will have a check mark by its name.
By default all major and minor keys will
be used. You can specify the keys you
want to use with the Set Global Keys
command in the Options menu. See page
24.

Major — All scales will be major.
Natural Minor — All scales will be

natural minor.
Harmonic Minor — All scales will be

harmonic minor.
Melodic Minor — All scales will be

melodic minor.
All Scales — Scales will be any of the

above four types.

The following items affect the way
MUSIC LESSONS I interprets your
answers. A check mark in the menu
indicates that it’s in effect.

Strict Answers — You have to spell each
note correctly. You may have to use
the keyboard popup menu or Acciden-
tal toolbar for special case acciden-
tals.
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Lenient Answers — If you play the
correct notes, they will be named
correctly.

Major / Minor Scales Custom Levels

Scales — Choose the type of scales you
wish to use.

Options — Choose strict or lenient
answers.

Major Keys — Choose any combination
of keys.

Minor Keys — Choose any combination
of keys.

Set Clef — Choose the clef. The clef
currently in effect is displayed to the
right of the button.

 MODES

This drill will help you learn the modal
scales. Modes were used by Renaissance
composers. Modes are used today in jazz,
pop and 20th century concert pieces. The
major and natural minor scales are derived
from the Ionian and Aeolian modes.

Modes Skill Levels

There are eight main levels. The level in
effect will have a check mark by its name.
By default any black or white key can be
used for the starting note. You can specify
the starting pitches you want to use with
the Set Global Keys command in the
Options menu. See page 24.

Ionian — All modes will be Ionian.
Dorian — All modes will be Dorian.
Phrygian — All modes will be Phry-

gian.
Lydian — All modes will be Lydian.
Mixolydian — All modes will be

Mixolydian.
Aeolian — All modes will be Aeolian.
Locrian — All modes will be Locrian
All Modes — All modes will be used.

The following items affect the way
MUSIC LESSONS I interprets your
answers. A check mark in the menu
indicates that it’s in effect.

Strict Answers — You have to spell each
note correctly. You may have to use the
keyboard popup menu or Accidental
Toolbar for special case accidentals.

Lenient Answers — If you play the correct
notes, they will be named correctly.

Modes Custom Levels

Modes — Choose the modes you wish to
use.

Options — Choose Strict Answers or
Lenient Answers.

Starting Pitches — Choose any
combination of starting notes to use
for the modes.

Set Clef — Choose the clef. The clef
currently in effect is displayed to the
right of the button.
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 JAZZ SCALES

This drill will help you learn what notes
are used in several jazz scales. The notes
of these scales are the raw materials for
improvised melodies in jazz.

Jazz Scales Skill Levels

There are seven main levels. The level in
effect will have a check mark by its name.
By default any black or white key can be
used for the starting note. You can specify
the starting pitches you want to use with
the Set Global Keys command in the
Options menu. See page 62.

Dorian Flat 2 — All scales will be
Dorian Flat 2.

Lydian Sharp 5— All scales will be
Lydian Sharp 5.

Mixolydian Sharp 4 — All scales will be
Mixolydian Sharp 4.

Mixolydian Flat 6 — All scales will be
Mixolydian Flat 6.

Minor Flat 5 — All scales will be Minor
Flat 5.

Locrian Flat 4 — All scales will be
Locrian Flat 4.

All Jazz Scales — All the above jazz
scales will be used.

The following items affect the way
MUSIC LESSONS I interprets your
answers. �A check mark in the menu
indicates that it’s in effect.

Strict Answers — You have to spell each
note correctly. You may have to use

the keyboard popup menu or Acciden-
tal Toolbar for special case acciden-
tals.

Lenient Answers — If you play the
correct notes, they will be named
correctly.

Jazz Scales Custom Levels

Jazz Scales — Choose the jazz scales
you wish to use.

Options — Choose Strict Answers or
Lenient Answers.

Starting Pitches — Choose any
combination of starting notes to use
for the jazz scales.

Set Clef — Choose the clef. The clef
currently in effect is displayed to the
right of the button.
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 SCALE DEGREES

This drill will help you learn a note’s
position within a major or minor scale or
key. Each scale degree (position) has a
name. The different scale degrees have
melodic and harmonic functions.
Knowing the scale degrees will be very
useful when studying melodies and
chords.

Scale Degrees Skill Levels

There are six main levels. The level in
effect will have a check mark by its name.
By default all major and minor keys will
be used. You can specify the keys you
want to use with the Set Global Keys
command in the Options menu. See page
24.

Major Scales — Notes from the major
scale will be used.

Natural Minor Scales — Notes from the
natural minor scale will be used.

Harmonic Minor Scales — Notes from
the harmonic minor scale will be
used.

Melodic Minor Scales — Notes from the
melodic minor scale will be used.

All Minor Scales — Notes from all
minor scales will be used.

All Scales — Notes from all major and
minor scales will be used.

The following items modify the current
skill level. A check mark in the menu
indicates that it’s in effect.

Theory Names — traditional theory
names: tonic, supertonic, mediant,
subdominant, dominant, submediant,
subtonic, leading tone

Solfege Names — moveable do names:
do, re, mi, fa, sol, la, sa, si

Number Names — numerical position
within the scale: 1, 2, 3, 4, 5, 6, x7, 7

Use Key Signatures — If this is checked,
a key signature appears in the staff
and the no accidentals appear in front
of notes. If it’s unchecked, no key
signature is displayed and accidentals
will appear in front of notes.

Scale Degree Toolbar
The Scale Degree Toolbar appears to the
left of the screen keyboard and lets you
select theory names, solfege names, or
number names.

Scale Degrees Custom Levels

Degree Choices — Choose the scale
degrees you wish to use.

Scales — Choose any combination of
scale types.

Key Options — Choose whether or not
to display key signatures. Click the
Set Custom Keys button to choose the
keys.

Set Clef — Choose the clef. The clef
currently in effect is displayed to the
right of the button.

Degree Names — Choose the syntax.
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 INTERVALS

This drill will help you learn to identify
intervals visually. An interval is the
distance in pitch, measured in half steps,
between two notes. Quick visual recogni-
tion of intervals is very important in sight
reading and transposing.

Intervals Skill Levels

There are three main levels. The level in
effect will have a check mark by its name.

Beginning — Interval sizes range from
unison to octave. Key signatures are
used. The first note of the interval is
the first note (tonic) of the major or
minor scale represented by the key
signature. Diminished and augmented
intervals are not used.

Intermediate — Interval sizes range
from unison to octave. Key signatures
are used. Both notes of the interval
belong to the major or minor scale
represented by the key signature and
can be any two scale notes. Doubly
diminished and doubly augmented
intervals are not used.

Advanced — Interval sizes range from
unison to tenth. Key signatures are not
used. The two notes of the interval
can be any notes altered by any
accidental. All intervals are used.

The following items modify the current
skill level. A check mark in the menu
indicates that it’s in effect.

Ascending — Use ascending intervals.

Descending — Use descending
intervals.

Ascending and Descending — Use both
ascending and descending intervals.

Set First Note — this opens the
following dialog where you can set
the first note of the interval to a
specific pitch.

You can specify the keys you want to use
in the Beginning and Intermediate levels
with the Set Global keys command in the
Options  menu. See page 24.

Intervals Custom Levels

Unison — Choose qualities for unisons.
Fourth — Choose qualities for fourths.
Fifth — Choose qualities for fifths.
Octave — Choose qualities for octaves.
Motion — Choose ascending intervals,

descending intervals, or both.
First Note — Choose the pitch for the

first note of the interval. The pitch
currently in effect is displayed to the
right of the button.

Set Clef — Choose the clef. The clef
currently in effect is displayed to the
right of the button.

2nds — Choose qualities for seconds.
3rds — Choose qualities for thirds.
6ths — Choose qualities for sixths.
7ths — Choose qualities for sevenths.
9ths — Choose qualities for ninths.
10ths — Choose qualities for tenths.
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Additional Settings for Intervals
Additional settings for the Intervals drill
are found on the Intervals/Scales ET (Ear
Training) page of the Preferences dialog.
You can specify whether intervals are to
be played melodically, harmonically, or
both.

You can set the number of times the
interval will be played when you get a
new question. If you’re using MIDI or
QuickTime sounds you can assign
different sounds to Interval Note 1 and
Interval Note 2. If you’re using different
sounds for Interval Note 1 and Interval
Note 2 you should assign them to
different MIDI channels. See page 35.

 NOTE / REST

DURATIONS
This drill will help you learn how many
beats a note or rest receives in various
time signatures. This is essential for
understanding how rhythm and counting
work.

Note/Rest Durations Skill Levels

There are three main levels. The level in
effect will have a check mark by its name.

Notes — Note symbols will be used.
Rests — Rest symbols will be used.
Both Notes and Rests — Both note and

rest symbols will be used.

The following item lets you choose
whether to use dotted notes. A check mark
in the menu indicates that it’s in effect.

Use Dots — If this is checked, dotted
notes will be used some of the time. If
it’s unchecked, no dotted notes will be
used.

The following items refer to the beat
value, the lower number in the time
signature. A check mark in the menu
indicates that it’s in effect.

Half Note Beat — The lower number of
the time signature is 2.

Quarter Note Beat — The lower number
of the time signature is 4.

Eighth Note Beat — The lower number
of the time signature is 8.

Sixteenth Note Beat — The lower
number of the time signature is 16.

All Beat Units — All time signatures
will be used.

The following items specify the levels of
beat divisions used. A check mark in the
menu indicates that it’s in effect.

First Beat Division — The smallest note
value used will be equal to the beat
value.

Second Beat Subdivision — The
smallest note value used will be the
next smallest value of the beat value.

All Beat Subdivisions — The smallest
note value used will be a sixteenth
note.

The following chart shows the relation-
ship between time signatures and beat
divisions. The upper number of the time
signature can be a 2, 3, 4, or 6 and is
shown as an X.
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Note/Rest Durations Custom Levels

Notes — Choose any combination of
note values. If you want to use dotted
notes, check Use Dotted Notes.

Rests — Choose any combination of rest
values. If you want to use dotted rests,
check Use Dotted Rests.

Time Signatures — Choose the upper
and lower numbers of the time
signature.

Set Clef — Choose the clef. The clef
currently in effect is displayed to the
right of the button.

 SCALES EAR

TRAINING
This drill will help you learn to identify
scales by listening. Learning to recognize
what you hear is an important musical
skill.

Scales Ear Training Skill Levels

There are three main levels. The level in
effect will have a check mark by its name.

Major / Minor Scales — The major and
three forms of the minor scales will be
used.

Modes — The seven modal scales will
be used.

Jazz Scales — The six jazz scales will
be used.

Scales Ear Training Custom Levels

Major / Minor — Choose any major and
minor scales.

Modes — Choose any modes.
Jazz Scales — Choose any jazz scales.
Set Starting Pitches — Choose the

starting pitches.
Set Clef — Choose the clef. The clef

currently in effect is displayed to the
right of the button.



20

MUSIC LESSONS I Reference Manual

 INTERVALS EAR

TRAINING
This drill will help you learn to identify
intervals by listening. Learning to
recognize what you hear is an important
musical skill.

Intervals Ear Training Skill Levels

There are three main levels. The level in
effect will have a check mark by its name.

Beginning — Interval sizes range from
unison to fifth.

Intermediate — Interval sizes range
from unison to octave.

Advanced — Interval sizes range from
unison to tenth.

The following items modify the current
skill level. A check mark in the menu
indicates that it’s in effect.

Ascending — Use ascending intervals.
Descending — Use descending

intervals.
Ascending and Descending — Use both

ascending and descending intervals.

Set First Pitch — Restrict the first note
of the interval to a specific pitch.

Intervals Ear Training Custom Levels

Interval Types — Select the interval
sizes and qualities.

First Pitch — Choose the pitch of the
first note of the interval. The pitch
currently in effect is displayed to the
right of the button.

Set Clef — Choose the clef. The clef
currently in effect is displayed to the
right of the button.

Interval Motion — Choose ascending
intervals, descending intervals, or
both.

Additional Settings for Intervals
Additional settings for the Intervals drill
are found on the Intervals / Scales ET
(Ear Training) page of the Preferences
dialog. You can specify whether intervals
are to be played melodically, harmoni-
cally, or both.

You can set the number of times the
interval will be played when you get a
new question. If you’re using MIDI or
QuickTime sounds you can assign
different sounds to Interval Note 1 and
Interval Note 2. If you’re using different
sounds for Interval Note 1 and Interval
Note 2 you should assign them to
different MIDI channels. See page 35.
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This section discusses the commands
found in MUSIC LESSONS I’s menus.

APPLE MENU
The first item in the Apple menu is About
MUSIC LESSONS I. This item displays a
dialog box containing the version number,
the registered user name, and information
about contacting MiBAC Music Software.

FILE MENU
The File menu contains commands that
allow you to create, open, save, and print
Progress Reports. It also contains the
Preferences command that lets you
customize MUSIC LESSONS I.

New Progress Report...
When you choose New Progress Report
the Name dialog box appears asking for
your name.

The name you type is attached to the
Progress Report window and cannot be
changed. Click OK and the Progress
Report window will open. In a classroom
or studio setting each student can have
her/his own progress report file. The
number of student files is limited only by
disk space. This menu item is disabled if a
Progress Report window is already open.
See the User Guide, pages 32-35.

Open Progress Report...
When you choose Open Progress Report
the Open File dialog box appears where
you select the Progress Report you want
to open. This menu item is disabled if a
Progress Report window is already open.
See the User Guide, pages 32-35.

Close
Closes the Progress Report or Help
window. If there are unsaved changes, you
will be asked if you want to save them.
This menu item is disabled if no Progress
Report window is open.

Save Progress Report
You normally use this command to save
scores to an existing file. When you save a
Progress Report the Session Scores will
be reset to zero. This menu item is
disabled if no Progress Report window is
open, or if there are no unsaved scores.

Save Progress Report As...
You normally use this command to save a
file for the first time, or to save an
existing file with a new name. This item
displays the standard Save dialog box,
where you can name and save a Progress
Report. This item is disabled if no
Progress Report window is open.

CHAPTER 2 - MENUS
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Page Setup...
Displays the standard Page Setup dialog
box. The exact appearance of the dialog
box depends on the printer selected in the
Chooser. The Chooser is found in the
Apple menu.

Print...
You can print Progress Report and Help
windows. The scores displayed in the
lower portion of the Progress Report
window will be printed. The file that’s
being displayed in the Help window will
be printed.

Preferences...
Displays the Preferences dialog box
where you can customize program
settings used by MUSIC LESSONS I.
There are fifteen pages in the Preferences
dialog that can be accessed by the
Preferences popup menu or by the Prev
and Next buttons. If you click the OK
button, the dialog will close and the
settings on all changed pages will be used
until you quit. If you click the Permanent
button, the dialog will remain open and
the settings on the current page will be
saved to a file called “MUSIC LESSONS
Preferences” in the Preferences folder
inside the System Folder and will be used
the next time you start the program.
Preferences are discussed in detail in
Chapter 3, Preferences, page 29.

Quit
Quits MUSIC LESSONS I. If there are
unsaved scores a dialog box will appear
giving you four choices. You can save
scores to an existing file; to a new file;

quit without saving; or cancel and return
to the program.

EDIT MENU
The Edit menu contains the usual cut,
copy, and paste commands.

DRILL MENU
The Drill menu contains commands that
allow you to choose one of twelve
different drills. The Drill menu is
discussed in detail in Part 5, Drills, page
39. The drill you want to use at program
start up can be set on the General page of
the Preferences dialog. See page 69.

LEVEL MENU
The Level menu refers to level of
difficulty. It is divided into two sections,
main and custom. The number of items in
the main section changes for each of the
twelve drills. The levels of difficulty in
the Main section range from easy to
difficult. The custom section stays the
same and lets you create, save, and load
four custom levels in each drill. The Level
menu for each drill is discussed in
Chapter 1, Drills, page 5.
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CLEFS
The Clefs menu lets you choose between
the treble, bass, alto, tenor, or any
combination of these clefs. The clef you
want to use at program start up can be set
on the General page of the Preferences
dialog. See page 30.

To work in a single clef, choose that clef
from the menu. To alternate between
clefs, choose the Random command and
select any combination of clefs.

INSTRUMENT MENU
The Instrument menu lets you choose
between the four or six octave piano, the
twelve or nineteen fret guitar, or alphabet
blocks that display accidentals as symbols
or text. The instrument you want to use at
program start up can be set on the General
page of the Preferences dialog. See page
30.

Instruments are discussed in the User
Guide, page 18. You can customize the
sound and appearance of the instruments
by using the Color, Piano, Guitar, and
Alphabet Block pages of the Preferences
dialog. See pages 31, 33-35

OPTIONS MENU
The Options menu contains commands
that affect the way you interact with the
program. Many of these options can be set
in the Preferences dialog so they’ll be in
effect at program start up.

Auto Next Note
The Auto Next Note command affects
only the current drill. When Auto Next
Note is on (has check mark), each time
you play a note the text insertion point
advances to the next answer box. When
you play several notes in a row, each note
is entered into successive answer boxes.
When Auto Next Note is off (no check
mark), every note you play stays in the
same answer box, replacing the note
previously there. You type the tab key or
right arrow key to move to the next
answer box. It is disabled in drills that
have only one answer box. You can set
Auto Next Note independently for each
drill using the Drill page in the Prefer-
ences dialog. See page 31.

Auto Next Question
The Auto Next Question command affects
only the current drill. When Auto Next
Question is on (has check mark), each
time you check your answers and they’re
correct, you’ll get a new question. When
Auto Next Question is off (no check
mark), you won’t get a new question, even
if your answers are correct. You can set
Auto Next Question independently for
each drill using the Drill page in the
Preferences dialog. See page 31.

Allow Typed Answers
The Allow Typed Answers command
affects all drills. If you want to type your
answers, be sure Allow Typed Answers is
on (has check mark). When it’s on, the
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program checks that the note name is
correct, but does not care if you played it
in the correct octave. When it’s off, both
the note name and octave position of the
note have to be correct. Allow Typed
Answers can be enabled at program start
up on the General page of the Preferences
dialog. See page 30.

Fast Answer Checking
When Fast Answer Checking is on (has
check mark), MUSIC LESSONS I
automatically checks your question as
soon as all answer boxes are filled. If your
answers are correct you’ll instantly get a
new question. If any answers are wrong,
the first wrong answer will be selected.
When you’ve corrected that answer, the
next wrong answer will be selected. As
soon as you’ve corrected all the wrong
answers, your answer will be checked
again. Fast Answer Checking is a rapid
way to improve your skills in all drills.
Fast Answer Checking can be enabled at
program start up on the General page of
the Preferences dialog. See page 30.

Set Global Keys...
Set Global Keys lets you specify the key
signatures or starting notes that will be
used in the Key Signatures, Major/Minor
Scales, Modes, Jazz Scales, Scale
Degrees, and Intervals drills. It has no
affect on custom levels. If you click OK,
the keys/notes will be used until you quit
from the program and will not be
remembered across program restarts. If
you click Permanent, the keys/notes will
be remembered across program restarts.

Reset Scores...
Sometimes you get off to a bad start and
just want to start over again. The Reset

Scores dialog lets you reset scores for the
current level of the current drill (Reset
Level), all levels of the current drill (Reset
Drill), or all levels of all drills (Reset All).
This only affects scores that have not been
saved and will not change any scores
already saved in your progress report.

SOUND MENU
The Sound menu contains commands that
let you choose the sound system you want
to use, choose whether you want to play
sound effects for right and wrong
answers, change the tempo, and specify
the MIDI instrument sounds. Many of
these options can be set in the Preferences
dialog so they’ll be in effect at program
start up. Sound is discussed in more detail
in Chapter 4, Sound, page 30.

Use Mac
When Use Mac is on (has check mark)
sounds play through your Mac speaker.
You can replace the sounds we use for the
piano and guitar with your own. See page
94. Mac sounds can be enabled at
program start up on the General page of
the Preferences dialog. See page 30.

Use MIDI
When Use MIDI is on (has check mark)
MUSIC LESSONS I can send and receive
MIDI messages. MUSIC LESSONS I
supports three MIDI systems: MiBAC’s
built in MIDI routines, Apple Computer’s
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MIDI Manager, and Opcode System’s
OMS (Open Music System). You can
select the MIDI system you want to use
from the MIDI Setup page of the
Preferences dialog. See page 72. MIDI
sounds can be enabled at program start up
on the General page of the Preferences
dialog. See page 30.

Use QuickTime
When Use QuickTime is on (has check
mark) MUSIC LESSONS I will play
notes using QuickTime Musical Instru-
ments sounds. QuickTime sounds can be
enabled at program start up on the
General page of the Preferences dialog.
See page 30. Different QuickTime sounds
can be chosen for each instrument in the
instrument pages of the Preferences
dialog. See pages 33-35. This menu item
and all QuickTime related options in the
Preferences dialog will be disabled if
QuickTime is not installed.

Use Sound
When Use Sound is on (has check mark)
you’ll hear sounds when you play the
screen instrument, and when you click the
Check, Play, or Show Me buttons. In
some situations you might want to turn
the sound off. For example, you’re
working in a public place and don’t want
to disturb others. Or, you’re looking for
faster feedback and want your answers
checked instantly, without having to wait
for each note to play. Use Sound can be
enabled at program start up on the
General page of the Preferences dialog.
See pages 21, 30.

Use Sound Effects
When Use Sound Effects is on (has check
mark) sound effects will be played after
checking your answer. You can assign
different sound effects to the correct
answer and the wrong answer by using the
Sound Effects page of the Preferences
dialog. See page 37. You can create and
use your own sound effects by recording
and saving a ‘snd ’ resource and adding it
to the Sound Effects folder. See page 51.

Sound effects can be enabled at program
start up on the General page of the
Preferences dialog. See page 30.

Set Tempo...
Set Tempo lets you change how fast the
answers play. You might want to make
answers play slowly so you have time to
watch the correct notes highlight on the
screen. You might want to make answers
play fast so you can get a new question
more quickly. If you click OK, the new
tempo will be used until you quit from the
program. If you click Permanent, the new
tempo will be remembered across
program restarts.

Set MIDI Patches...
Set MIDI Patches lets you assign different
MIDI sounds (patches) to the piano,
guitar, and alphabet block instruments;
and to Interval Note 1, Interval Note 2,
and Scales Ear Training sounds.

Use the Device popup menu to choose
your synthesizer. Use the Apply To popup
menu to specify which instrument or drill
sound you’re setting. Then click any cell
to set the patch (sound) for that instru-
ment. If Play On Click is checked, you’ll
hear the sound whenever you click a patch
name. If you click OK, your choices will
be used for the remainder of this session.
If you click Permanent your choices will
be remembered across program restarts.
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If your synthesizer isn’t listed in the
Device menu, you can create a patch list
file in a text editor and copy it to the
Synthesizer Name Files folder. See page
50.

WINDOW MENU
The Window menu lets you switch easily
between Drill windows, Progress Report
windows, and Help windows.

HELP MENU
The Help menu is displayed as a question
mark icon at the right side of the menu
bar. It contains commands to turn balloon
help on and off,  and to open the MUSIC
LESSONS I Help window.

Show Balloons / Hide Balloons
Choose Show Balloons to turn balloon
help on.

When Balloon Help is on, balloons appear
when the mouse is moved over areas of
the screen. The following picture shows
the help balloon that appears when the
mouse is moved over the Help icon in the
Drill toolbar.

Balloon help is available for all menu
items, dialogs, and drill windows used in
MUSIC LESSONS I. Choose Hide
Balloons to turn balloon help off.

MUSIC LESSONS I Help
A complete music theory reference is
available by choosing Help from the
Window menu, clicking the Help button
in the toolbar, or choosing the MUSIC
LESSONS I Help command from the
Help Menu.

We’ve supplied help files explaining the
music theory for all the drills in MUSIC
LESSONS I as well as instructions for
using the program. The following picture
shows the MUSIC LESSONS I Help
window.

The Help window is divided into three
parts. The File List in the lower left
displays the help files in the MUSIC
LESSONS I Help folder. When you click
a file name in the File List, the topics in
that file appear in the Topic List in the
upper left, and the contents of the file will
appear in the Contents area on the right.
When you click a topic in the Topic List,
that topic will scroll into view in the
Contents area.

When you see a speaker button in the help
file, double click the speaker to play the
sound.
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The MUSIC LESSONS I Help system is
extensible. You can create and add your
own files to the MUSIC LESSONS I Help
folder. Help files can be created with the
ML Help Editor application and are just
TEXT files containing colored, styled
text, pictures, and sounds. Once you’ve
created a help file, just copy it to the
MUSIC LESSONS I Help folder, and it
will show up in the File List in the Help
window. See page 50 for information on
creating your own help files.

Help files can be printed by choosing the
Print command in the File menu.
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This section discusses the Preferences
dialog where you can customize MUSIC
LESSONS I. You can open the Prefer-
ences dialog by choosing the Preferences
command in the File menu.

COMMON ELEMENTS
You can access he fifteen pages in the
Preferences dialog using the Preferences
popup menu or the Prev and Next buttons.

The following elements are common to
each of the fifteen pages.

OK Button
Click the OK button to close the dialog
and set the program preferences on all

CHAPTER 3 - PREFERENCES

changed pages. These settings remain in
effect until you quit the program.

Permanent Button
 If you click the Permanent button, the
dialog will remain open and the settings
on the current page will be saved to a file
called “MUSIC LESSONS Preferences”
in the Preferences folder inside the
System Folder. These settings will be used
the next time you start the program.

Defaults
Click the Defaults button to reset the
current page to MUSIC LESSONS I’s
default settings.

<<Prev and Next>> Buttons
Click the Prev or Next buttons to move to
the previous preference page or the next
preference page. Changes you make to
different pages will go into effect once
you click the OK button. If you want
settings on the current page to be
remembered across program restarts, you
must click the Permanent button before
moving to a new page.

Cancel
Click Cancel to exit from the Preferences
dialog without changing or saving any
settings, even if you’ve clicked the
Permanent button.

Clusters
A group of check boxes surrounded by a
rectangular frame is called a cluster. Each
cluster has a descriptive title. Click the
cluster title to quickly turn all check
boxes within the cluster on and off.
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Spin Buttons
Spin Buttons appear to the right of a text
entry box. You can type a value directly
into the text box or click the up or down
arrow of the spin button to increase or
decrease the value. The range of permitted
values appears below the text entry box.

Speaker Button
If an item has a speaker button, you can
click the speaker to play the sound.

GENERAL
The General page affects the program
start up state, the sound system used, and
answer checking. To make these settings
permanent, remember to click the
Permanent button.

Startup Drill
Choose the drill to be used at program
start up.

Sound
Choose the sound system you want to use.

Use Sound
Use Sound should be checked if you want
to hear the sounds.

Use Sound Effects
Use Sound Effects should be checked if
you want to hear sound effects played for
right and wrong answers.

Startup Instrument
Choose the instrument to be used at
program start up.

Startup Clef
Choose the clef to be used at program
start up.

Scales Answers
Choose whether you want the program to
use Strict or Lenient Answers in the
Major/Minor Scales, Modes, and Jazz
Scales drills. Strict Answers requires you
to spell notes correctly. Lenient Answers
lets you play the notes on your keyboard
and automatically call the notes by their
correct names. See pages 47-48.

Allow Typed Answers
If you want to type your answers, turn on
Allow Typed Answers. When this is on,
MUSIC LESSONS I doesn’t care if you
play the note in the correct octave, only
that you get the name right. This item
affects all twelve drills.

Fast Answer Checking
When Fast Answer Checking is on,
MUSIC LESSONS I automatically checks
your answers when you’ve reached the
last answer box. If your answers are
correct you’ll instantly get a new
question. If any answers are wrong, the
first wrong answer will be selected. When
you’ve corrected that answer, the next
wrong answer will be selected. As soon as
you’ve corrected all wrong answers, your
answer will be checked again. This item
affects all twelve drills.
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DRILL
The Drill page has settings that affect
your interaction with the program. To
make these settings permanent, click the
Permanent button.

Auto Next Question
When Auto Next Question is on, you’ll
get a new question after you’ve checked
your answer and it was correct. You can
set Auto Next Question independently for
each drill.

Auto Next Note
When Auto Next Note is on, the text
insertion point advances to the next
answer box each time you play a note.
When it’s off, each note you play remains
in the same answer box. You use the tab
key or right arrow key to move to the next
answer box. You can set Auto Next Note
independently for each drill that has more
than one answer box.

Note Names
If Alphabet is selected, notes will be
called A B C D E F G. If Solfege is
selected, notes will be called Do Re Mi Fa
Sol La Si. The solfege system is a fixed
Do system; the note C is always Do.

Custom Levels
The Dim Unused Selections check box is
found on the Drill page of the Preferences
dialog. It affects the display of answer
buttons in Custom Levels you create in
any of the six multiple choice drills: Key
Signatures, Scale Degrees, Intervals, Note
Rest Durations, Scales Ear Training, and
Intervals Ear Training. When the Dim
Unused Selections check box is off, all

answer buttons are enabled, even though
only a few may have been used for the
questions. When the Dim Unused
Selections check box is off, only those
answer buttons that are actually used are
enabled; the others are disabled.

Here’s an example from an Intervals Ear
Training custom level that uses major and
minor seconds and thirds.

Dim Unused Selections On

Dim Unused Selections Off

COLOR
The Color page lets you choose colors for
items drawn in the drill windows. To
make these settings permanent, click the
Permanent button. A representative
display of your settings is shown in the
Screen Elements portion of the dialog.

Select An Item:
Select one of the items from this list. You
will have to use the scroll bar to see all 19
items. And then…

Choose a Color:
Click one of the sixteen color squares to
set the color for the selected item.
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Screen Elements:
This displays a representation of the
screen so you can see how your color
choices look.

Set Color Button
If the color you want isn’t in the 16 color
squares, click the Set Color button to pick
a different color. The new color will
appear in the lower right square.

Answer Flashes
When you get an answer right, a rectangle
above the answer boxes flashes to indicate
that the answer was correct. You can set
the number of times that the rectangle
flashes. You can turn the flashing off by
setting this number to zero.

FONT
The Font page lets you choose the font,
size, style, and color for text elements
drawn in the drill windows. To make these
settings permanent, click the Permanent
button. A representative display of your
settings is shown in the lower portion of
the dialog.

Font, Size, Style Popup Menus
Choose the font, size, and style to be used
for the text element indicated by the
selected radio button. Large font sizes
may not look good on small screens.

Color Rectangle Popup Menus
Click the color rectangle to the right of
each radio button to choose the text color
for that item.

Set Color...
If the color you want isn’t in the color

rectangle popup menu, click the Set Color
button to pick a different color. The new
color you choose will show up in the
lower right corner of the color rectangle
popup menu.

MAC SOUND SETUP
The Mac Sound Setup page lets you set
the sound volume for sampled sounds and
QuickTime sounds relative to the master
volume setting found in the Sound control
panel. See page 39. To make these
settings permanent, click the Permanent
button.

Sampled Sound Volume
Set the volume of the sampled sounds for
the piano and guitar instruments.

QuickTime Volume
Set the volume for the QuickTime
Musical Instrument sounds.

Sustain Time
The Sustain Time setting affects the
length of time a sampled sound sustains
after clicking a note on the keyboard.
Sustain Time is measured in ticks, with 60
ticks equal to one second. For example,
using a sustain time of 1, you can click
different notes on the keyboard as fast as
possible and the highlighting of the keys
will keep up with the clicks. However, the
sounds of the notes will be clipped short.
If you set the sustain time to 60, the sound
of the notes will last for one second but
there will be a lag between the highlight-
ing of the keys and the time you click. A
sustain time of 25 works well. Sustain
time has no effect on MIDI.
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MIDI SETUP
The MIDI Setup page lets you select
MIDI drivers, set the MIDI Input
Transpose value, configure your MIDI
interface, use QuickTime output with
MIDI input, and use MIDI Echo. To make
these settings permanent, click the
Permanent button.

MIDI System
MUSIC LESSONS I supports three MIDI
systems: MiBAC’s built in MIDI, OMS,
and MIDI Manager. OMS and MIDI
Manager do not come with MUSIC
LESSONS I but can be used if you
already have them. See pages 42-45 for
details on configuring your system. See
page 53 for information on obtaining
OMS and MIDI Manager.

Input Transpose
Input Transpose is useful with guitar and
wind controllers, and with pitch input
devices that let you sing or play into a
microphone to answer questions. When
MIDI pitch data is received from your
controller, it is transposed by the Input
Transpose value (number of half steps)
before being processed by MUSIC
LESSONS I. For example, if you’re using
a Bx transposing instrument, you would
set the MIDI input transpose value to 2.
MIDI Input Transpose values can range
from -12 to +12.

Port / Clock Rate
This area of the dialog changes depending
on which MIDI system is selected. See
pages 42-45.

QuickTime Output
Turn QuickTime Output on if you’re
using a MIDI keyboard controller that has
no sounds of its own, and you want the
controller to play QuickTime sounds.

Use MIDI Echo
Turn Use MIDI Echo on if you’re using a
MIDI keyboard controller and a MIDI
sound module. See the User Guide, page
13. When Use MIDI Echo is on, notes
played on the controller are sent to the
sound module using the channel, patch,
and velocity specified for the current
MUSIC LESSONS I instrument.

PIANO
The Piano page lets you set the range and
sound used for the piano instrument. To
make these settings permanent, click the
Permanent button.

Keyboard Range
The piano instrument can display four or
six octaves. See the User Guide, page 18.

Display Name Balloons
You can have balloons display the names
of notes above the keyboard keys.

There are three settings.

On Check and Show Me
Display note name balloons when you
click the Check or Show Me button.
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Always
Display note name balloons whenever you
play a note on the keyboard or click
Check or Show Me.

Never
Don’t use the note name balloons.

Mac Sampled Sound
You can use either a piano or guitar sound
for this instrument. You can also record
and use your own sounds. See page 52.

QuickTime Sound
Click the Set button to choose any of the
QuickTime Musical Instruments. See
page 41.

MIDI Sound
Set Patch
Click the Set Patch button to open the Set
Patches dialog where you select the patch
(MIDI instrument sound) for the piano
instrument. See pages 44-45.

Channel
Set the MIDI channel for the piano.

Velocity
Set the velocity (loudness) of the
transmitted MIDI sound.

Output Transpose
Choose whether you want the MIDI
sound to be transposed up or down an
octave.

GUITAR
The Guitar page lets you set the range,
orientation, and sound used for the guitar
instrument. To make these settings
permanent, click the Permanent button.

Guitar Fingerboard Layout
The guitar instrument can display 12 or
19 frets. You can specify whether the low
E string appears at the top or bottom of
the instrument and whether to display fret
numbers. See the User Guide, page 18.

Treble Clef Sounds
Guitar Pitch (Down Octave)
Guitar music is written in treble clef,
although its actual sound is one octave
lower. When this button is checked,
MUSIC LESSONS I will display notes in
treble clef but play notes one octave
lower. Use this setting with MIDI guitar
controllers.

Piano Pitch
Notes sound at their written pitch. The
screen guitar will play notes one octave
higher than a normal guitar.

Display Name Balloons
You can have balloons display the names
of notes above the fingerboard.

 There are three settings.

On Check and Show Me
Display note name balloons when you
click the Check or Show Me button.

Always
Display note name balloons whenever you
play a note on the fingerboard or click
Check or Show Me.

Never
Don’t use the note name balloons.

Mac Sampled Sound
You can use either a piano or guitar sound
for this instrument. You can also record
and use your own sounds. See page 52.

QuickTime Sound
Click the Set button to choose any of the
QuickTime Musical Instruments. See
page 41.
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MIDI Sound
Set Patch
Click the Set Patch button to open the Set
Patches dialog where you select the patch
(MIDI instrument sound) for the guitar
instrument. See pages 44-45.

Channel
Set the MIDI channel for the guitar.

Velocity
Set the velocity (loudness) of the
transmitted MIDI sound.

Output Transpose
Choose whether you want the MIDI
sound to be transposed up or down an
octave.

ALPHABET BLOCKS
The Alphabet Blocks page lets you set the
appearance and sound used for the
Alphabet Blocks instrument. To make
these settings permanent, click the
Permanent button.

Accidental Names
The Alphabet Blocks instrument can
display accidentals using text or symbols.
See the User Guide, page 18.

Mac Sampled Sound
You can use either a piano or guitar sound
for this instrument. You can also record
and use your own sounds. See page 52.

QuickTime Sound
Click the Set button to choose any of the
QuickTime Musical Instruments. See
page 41.

MIDI Sound

Set Patch
Click the Set Patch button to open the Set
Patches dialog where you select the patch
(MIDI instrument sound) for the alphabet
block instrument. See pages 44-45.

Channel
Set the MIDI channel for the Alphabet
Blocks.

Velocity
Set the velocity (loudness) of the
transmitted MIDI sound.

Output Transpose
Choose whether you want the MIDI
sound to be transposed up or down an
octave.

INTERVALS / SCALES ET
The Intervals/Scales ET (Ear Training)
page lets you set the sound used for the
Interval Note 1, Interval Note 2, and
Scales Ear Training sounds.

Drill Sound
The radio button selected here indicates
the sound to be changed. You can choose
different settings for Interval Note 1,
Interval Note 2, and Scales Ear Training.

Intervals Play Options
You can specify whether intervals are to
be played melodically, harmonically, or
both.
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Intervals Play Times

Visual sets the number of times the
interval is played in the Intervals drill. Ear
Training sets the number of times the
interval is played in the Intervals Ear
Training drill.

Mac Sampled Sound
You can use a piano or guitar sound for
Interval Note 1, Interval Note 2, or Scales
Ear Training sounds. You must use the
same sounds for Interval Note 1 and
Interval Note 2. You can also record and
use your own sounds. See page 52.

QuickTime Sound
Click the Set button to choose any of the
QuickTime Musical Instrument sounds for
Interval Note 1, Interval Note 2, or Scales
Ear Training. See page 41.

MIDI Sound
Set Patch
Click the Set Patch button to open the Set
Patches dialog where you select the patch
(MIDI instrument sound) for Interval
Note 1, Interval Note 2, or Scales Ear
Training sounds. If you’re using different
patches (sounds) for Interval Note 1 and
Interval Note 2, you should assign them to
different MIDI channels. See pages 44-45.

Channel
Set the MIDI channel for Interval Note 1,
Interval Note 2, or Scales Ear Training. If
you’re using different sounds for Interval
Note 1 and Interval Note 2, you should
assign them to different MIDI channels.

Velocity
Set the velocity (loudness) of the
transmitted MIDI sound. If you’re using
different sounds for Interval Note 1 and
Interval Note 2, you can use different
velocities to balance the sound level.

Output Transpose
Choose whether you want the MIDI
sound to be transposed up or down an
octave.

MIDI SHORTCUT KEYS
The MIDI Shortcut Keys page lets you
assign keys on your MIDI synthesizer to
function as shortcuts for the Check, Next,
Play, and Show Me buttons and for
navigating through the answer boxes. To
make these settings permanent, click the
Permanent button.

Assign MIDI Shortcut Keys
You can type the MIDI note number in the
text box, play a key on your MIDI
synthesizer, or click a key on the piano
keyboard picture to automatically fill in
the text box. Use the tab key to move
between the text boxes. You can assign
shortcuts for the four clefs. If you enter
zero in a text box, the shortcut for that
item will be ignored. The Tab L box
assigns a key on your synthesizer that
moves one answer box to the left. The Tab
R box assigns a key on your synthesizer
that moves one answer box to the right.

Use MIDI Shortcuts
You must check Use MIDI Shortcuts to
activate the shortcuts.

PROGRESS
The Progress page lets you set the text
colors used in the Progress Report. A
representative display of your settings is
shown in the lower portion of the dialog.
To make these settings permanent, click
the Permanent button.
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Text Colors
Use the color popup menu to the right of
each radio button to set the color for that
element.

Set Color...
If the color you want isn’t in the color
popup menu, click the Set Color button to
choose a new color. The new color you
choose will appear in the lower right
corner of the color popup menu.

Printing Options
If you have a color printer, and want to
print in color, select Color. Otherwise,
select Black & White. If you select Color
on a black and white printer you may get
unexpected results.

SOUND EFFECTS
The Sound Effects page lets you choose
sound effects that will be played for right
and wrong answers. To make these
settings permanent, click the Permanent
button.

Sound Effects Choices
Select the Correct Answer or Wrong
Answer radio button and then choose a
sound effect from the list on the right.

To activate the sound effects, you must
also check Use Sound Effects in the
Sound menu or on the General page of the
Preferences dialog. See pages 25, 30.

You can record your own sound effects
and add them to the Sound Effects folder.
See page 51.

SCREEN SIZE
The Screen Size page lets you choose the
size of the drill window. To make these
settings permanent, click the Permanent
button.

Select The Screen Size
If you have a large screen display, you can
change the size of the MUSIC LESSONS
I Drill window.

PITCH INPUT DEVICE
The Pitch Input Device page has settings
that are helpful when using MUSIC
LESSONS I with pitch input devices. See
page 52. These devices let you sing or
play into a microphone to answer
questions. To make these settings
permanent, click the Permanent button.
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Pitch Input Device Settings
Show Play First Pitch Button
The Show Play First Pitch Button adds a
button to the Instrument toolbar just
below the Alphabet Blocks button. Click
this button to play the first pitch of the
question.

Play First Pitch On New Questions
If Play First Pitch On New Questions is
checked, the first pitch of the question
will be played whenever you get a new
question.

MIDI Shortcut Keys
You may want to disable MIDI Shortcut
keys while using a pitch input device so
you don’t accidentally sing or play a note
that triggers a shortcut.
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This section examines the options you
have for using sound in MUSIC LES-
SONS I. You can play sound through the
Mac speaker or through a MIDI synthe-
sizer. Sounds generated by the Mac and
played through the speaker are referred to
as sampled sounds. Sounds played
through a MIDI synthesizer are referred to
as MIDI sounds.

MAC SOUND SETUP
If you use sampled sounds, no special
equipment is needed. Sounds can be
played directly through the Mac speaker.
However, you’ll get better sound quality if
you connect a cable from the Sound
Output Port on the back of the Mac to
amplified speakers or headphones. A
stereo system will work just fine.

Warning:  Do not connect the sound
output port on the back of the Mac
directly to an unamplified speaker.

Mac Sound Volume
Open the Sound Control Panel and select
Volumes from the popup menu.

Use the slider controls on the Volumes
page of the Sound Control Panel to set the
master volume. If you’re playing sounds
through the Mac speaker, you’ll probably
want to move the volume controls all the
way to the top. If you’re using head-
phones or amplified speakers, you’ll
probably want to set the volume controls
low and then use your amplifier for the
final adjustment.

The Mac Sound Setup page of the
Preferences dialog sets the volume within
MUSIC LESSONS I relative to the sound
control panel volume. Select the volume
you want for sampled sounds or Quick-
Time sounds. You can click the speaker
button to hear the sound. When you’ve
found the setting you like, click the
Permanent button.

CHAPTER 4 - SOUND
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MIDI SETUP
If you’re using MIDI, you’ll need a MIDI
interface, a cable to connect the MIDI
interface to the Mac, two MIDI cables to
connect the MIDI interface to the
synthesizer, and a MIDI synthesizer.

Caution: Make sure your computer and
synthesizer are powered off when making
these connections.

The simplest setup uses a MIDI synthe-
sizer with built in sounds.

A slightly more complex setup uses a
MIDI keyboard controller (no sounds of
its own) and a MIDI sound module (has
sounds, but doesn’t have keys). You’ll
need to enable Use MIDI Echo. See page
72.

A standard printer cable connects the
MIDI Interface to the modem port
(recommended) or printer port on the
back of the Mac. The MIDI interface
functions as a high speed modem that
transmits data between the computer and

synthesizer. Two MIDI cables connect the
synthesizer to the MIDI interface. MIDI
cable connections go to opposite label
names. MIDI In on the interface is
connected to MIDI Out on the synthe-
sizer. MIDI Out on the interface is
connected to MIDI In on the synthesizer.
Audio Out from the synthesizer is
connected to your sound system. Refer to
your MIDI interface and synthesizer
manuals for additional information.

MIDI Sound Volume
Use the controls on your synthesizer,
amplifier, and/or powered speakers to
adjust the sound volume.

SAMPLED SOUNDS
MUSIC LESSONS I can play ‘snd ’
resource sampled sounds or the new
QuickTime Musical Instruments sounds
through the computer speaker. MUSIC
LESSONS I comes with built in ‘snd ’
resources for the piano and guitar.

When the Use Mac command in the
Sound menu is on (has check mark)
MUSIC LESSONS I plays sounds
through your Macintosh speaker.

If you want sampled sounds to be used at
program start up, open the Preferences
dialog from the File menu and go to the
General page. Select Mac and Use Sound
from the Sound cluster, and click the
Permanent button.
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Creating Your Own Sounds
If you’re technically inclined you can
replace the sounds we use for piano and
guitar with your own. See page 52.

QUICKTIME SOUNDS
QuickTime and QuickTime Musical
Instruments let you play high quality
instrument sounds through your computer
speaker. MUSIC LESSONS I will use
QuickTime sounds when Use QuickTime
is checked in the Sound menu. Use Sound
must also be checked to hear the sounds.

If you want QuickTime sounds to be used
at program start up, open the Preferences
dialog from the File menu and go to the
General page. Select QuickTime and Use
Sound from the Sound cluster, and click
the Permanent button.

It’s possible to use QuickTime sounds
with a MIDI keyboard controller. See
page 45.

QUICKTIME INSTRUMENTS
You can choose different QuickTime
instrument sounds for the piano, guitar,
alphabet block, Interval Note 1, Interval
Note 2, and Scales Ear Training sounds
using the Preferences dialog. We’ll assign
QuickTime sounds to the piano. The other
instruments work similarly. Open the
Preferences dialog and move to the Piano
page.

In the QuickTime Sound cluster click the
Set button and the QuickTime Instrument
Picker will appear. Use the popup menus
to select the instrument you want to use.

QuickTime Musical Instruments contain
standard General MIDI instruments. The
Category popup menu lists instrument
families; the Instrument popup menu lists
instruments available in that family.
Instruments shown in italics are not
available in Apple’s QuickTime Musical
Instruments. You can play the instrument
by clicking the piano keys.

Follow a similar procedure to set
QuickTime sounds for the guitar, alphabet
blocks, Interval Note 1, Interval Note 2,
and Scales Ear Training sounds using the
Guitar, Alphabet Block, and Intervals/SET
pages of the Preferences dialog.
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MIDI SOUNDS
When Use MIDI is checked in the Sound
menu, MUSIC LESSONS I can transmit
and receive MIDI data. Use Sound must
also be checked to hear the sounds.

If you want MIDI to be used at program
start up, open the Preferences dialog from
the File menu and go to the General page.
Select MIDI and Use Sound from the
Sound cluster, and click the Permanent
button.

MIDI SYSTEMS
MUSIC LESSONS I supports three MIDI
systems: MiBAC’s built in routines,
Opcode System’s OMS (Open Music
System), and Apple Computer’s MIDI
Manager.

Note: If you’re using a newer Mac with a
USB MIDI Interface, you’ll need to use
the OMS system.

If you want a specific MIDI System to be
used at program start up, open the
Preferences dialog and go to the MIDI
Setup page as shown in the following
picture. Select the MIDI system you want
to use and then click the Permanent
button. The MiBAC MIDI Drivers button
is always available. The OMS and MIDI
Manager buttons will be enabled if they
are installed. See the User Guide, page 11.
See page 33 in this manuals.

MiBAC MIDI Drivers
When the MiBAC MIDI Drivers button is
selected, use the right hand side of the
dialog to select the port and clock rate for
your MIDI interface. Most MIDI
interfaces use the 1 MHz clock rate. We
recommend you use the Modem port if
possible.

OMS (Open Music System)
OMS is written and maintained by
Opcode Music Systems. If OMS is
installed, and you select the OMS radio
button, you’ll see the following dialog.

The right hand side of the dialog has
popup menus to choose your MIDI Input
and MIDI Output devices. There are
buttons for opening the OMS MIDI Setup
dialog and the OMS Studio Setup
application. The following pictures are
from OMS 2.x.

MIDI Input / MIDI Output
Use these popup menus to specify the
MIDI synthesizers you’ll be using for
input and output . If none are listed you’ll
need to create your OMS configuration
file. In OMS 2.x and later, one of the
options for MIDI Output is QuickTime.
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OMS MIDI Setup
The OMS MIDI Setup button opens the
OMS MIDI Setup dialog where you can
choose modem or printer port.

OMS Studio Setup
The OMS Studio Setup button on the
MIDI Setup page of the Preferences
dialog opens the OMS Studio setup
application where you define your MIDI
studio.

Click the Std. Interface, Modem icon, as
shown in the picture above, to open the
MIDI Interface dialog where you select
the clock rate for your MIDI interface.

Click a synthesizer device icon, like D-10,
in the OMS Studio Setup window to open
the MIDI Device Info window where you
define the characteristics of that device.

MIDI Manager (Apple Computer)
MIDI Manager was written by Apple
Computer. The latest version is 2.0.2.
However, it is no longer supported by
Apple. MIDI features are being incorpo-
rated into future versions of QuickTime.

MIDI Manager requires the following
files.

In the System Folder:

In the Extensions Folder in the System
Folder:

This application can be anywhere:

The easiest way to install these files is to
drag the icons for Apple MIDI Driver and
MIDI Manager on top of your System
Folder icon. The files will be placed in the
correct folders. Restart your computer.

Open the Preferences dialog and go to the
MIDI Setup page. When you select the
MIDI Manager radio button, the right
hand side of the dialog tells you to use the
Patch Bay application to configure MIDI
Manager.
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Open the Patch Bay application. You
should see the Apple MIDI Driver icon on
the left and the MUSIC LESSONS I icon
on the right. Horizontal lines connect the
input and output ports of the two icons. If
you don’t see the horizontal lines, use the
mouse to drag a line from one triangle to
another.

If you double click the Apple MIDI
Driver icon (the one on the left) in the
PatchBay window, the Apple MIDI Driver
Settings window appears where you can
set the port and clock rate of your MIDI
interface.

Save Patch Bay Settings
You can save your PatchBay Setting by
choosing the Save PatchBay Settings
command from the Sound menu. This

menu item is only present when you are
using MIDI Manager.

OTHER MIDI SETTINGS
You can set the MIDI channel, velocity,
and patch (sound) for the piano, guitar,
alphabet block, Interval Note 1, Interval
Note 2 and Scales Ear Training sounds in
the Preferences dialog. The following text
refers to the Piano page of the Preferences
dialog. The Guitar, Alphabet Block, and
Intervals/SET pages work in a similar
manner.

Set Patches
In the MIDI Sound cluster on the Piano
page of the Preferences dialog, click the
Set Patch button to open the Set MIDI
Patches dialog.

Use the Device popup menu to choose
your synthesizer. Use the Apply To popup
menu to specify which instrument or drill
sound you’re setting. Then click any cell
to set the patch (sound) for that instru-
ment. If Play On Click is checked, you’ll
hear the sound whenever you click a patch
name. If you click OK, your choices will
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be used for the remainder of this session.
If you click Permanent, your choices will
be remembered across program restarts.

If your synthesizer isn’t listed in the
Device menu, you can create a patch list
file in a text editor and copy it to the
Synthesizer Name Files folder. See page
50.

MIDI Channels
In the MIDI Sound cluster set the MIDI
channels for the piano instrument.

MIDI Velocity
MIDI Velocity refers to how soft or loud
the sound plays. In the MIDI Sound
cluster set the MIDI velocity for the piano
instrument.

Output Transpose
The transpose cluster allows you to adjust
the octave register of the sound.

MIDI Input Transpose
The MIDI Input Transpose settings are
found on the MIDI Setup page of the
Preferences dialog. Input transpose is
useful with guitar and wind controllers,
and with pitch input devices that let you
sing or play into a microphone to answer
questions. When MIDI pitch data is
received, it is transposed by the Input
Transpose value number of half steps
before being processed by MUSIC
LESSONS I. For example, if you’re using
a Bx transposing instrument, you would
set the MIDI input transpose value to 2.
MIDI Input Transpose values can range
from -12 to +12. The Input transpose
value can be set separately for each clef.

QuickTime Output
QuickTime Output is found on the MIDI
Setup page of the Preferences dialog. You
can set up your MIDI controller (no
sounds of its own) to play QuickTime
sounds through the Mac speaker by
turning on QuickTime Output.

Use MIDI Echo
Use MIDI Echo is found on the MIDI
Setup page of the Preferences dialog.
When Use MIDI Echo is on, MUSIC
LESSONS I will transmit MIDI data it
receives to the sound module using the
channel, patch, and velocity specified for
the current MUSIC LESSONS I instru-
ment. If you’re using a MIDI controller
(no sounds of its own) and want the
sounds to play through a MIDI sound
module turn on Use MIDI Echo.
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I. SHORTCUTS
There are many time saving shortcuts
built into MUSIC LESSONS I. When you
see “type Command-M” this  means hold
down the Command key (the Apple,
clover leaf, propeller key) and type m.
The letter is shown in upper case. You can
type it in lower case.

Menu Items
When a menu item has a clover leaf
symbol followed by a letter, it indicates
that typing Command-letter is the same as
choosing that menu item with the mouse.

Buttons
Check
Type return or enter.

Next
Type Command-E.

Play
Type Command-L.

Show Me
Type Command-H.

Answer Boxes
Tab Key, Right Arrow Key
Moves one answer box to the right.

Shift-Tab Key, Left Arrow Key
Moves one answer box to the left.

MIDI
The MIDI Shortcuts page of the Prefer-
ence dialog lets you assign keys on your
synthesizer to function as the Check,
Next, Play, and Show Me button so you
won’t have to move your hands between
the synthesizer to the mouse.

In the Key Signatures drill you can play a
MIDI synthesizer key to answer ques-
tions.

Dialog Boxes
Default button
The default button is indicated by a thick
black outline around the button. Typing
return or enter is the same as clicking the
outlined button.

Cancel button
Typing Command-. (period) is the same
as clicking the Cancel button.

Clusters
A group of check boxes surrounded by a
rectangular frame is called a cluster. Each
cluster has a title. You can click the
cluster title as a shortcut to turn all the
check boxes within the cluster on and off
quickly.

Accidental toolbar
There are command key shortcuts for each
accidental. Press the Command key and
type the letter shown.

Five Finger Position drill
If Use Hints is enabled in the Level menu
of the Five Finger Position drill, the light
bulb icon will appear to the left of the
screen piano. Typing Command-I is the
same as clicking the light bulb. See page
11.

APPENDIXES
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II. TECH SUPPORT
Before calling MiBAC for help, read
through the Frequently Asked Questions
(FAQ) list that follows. When you contact
MiBAC for tech support we’ll need your
program serial number.

Email is our preferred method of technical
support.

Email (tech@mibac.com)
Email is checked and answered regularly.
Send your questions to tech@mibac.com.

Phone (507) 645-5851
Our tech support staff is small. You may
need to leave a message. We’ll call back.
Leave both a day and evening number.

Fax (507) 645-2377
Fax your question and it will be answered
by fax or email or phone.

Website (www.mibac.com)

III. FREQUENTLY ASKED
QUESTIONS (FAQ)
How many student records can I
keep?
The number of student files is limited
only by disk space. You could have
thousands on a hard drive.

When I play my MIDI keyboard, I see
the notes highlight on the screen
but I don’t hear any sound.
Since the screen highlights, MIDI In is
working. The problem is with MIDI Out.

• MIDI Synthesizer volume is not turned
on.

• The MIDI cable is connected incor-
rectly or the MIDI cable is bad.

• If you’re using a MIDI controller and
sound module, you’ll need to enable
MIDI Echo.

• If you’re using OMS or MIDI
Manager, they’re not configured
properly. Try using the built in
MiBAC routines.

 See Chapter 4, Sound, page 39.

Is a site license for MUSIC
LESSONS I available?
Our standard site license is good for up to
40 computers in a single building. The
site license includes two copies of the
manual, a special site license version of
the MUSIC LESSONS I application, and
license forms. The Preferences dialog and
the Set Custom Level dialogs are
password protected in the site license
version.

We also have lab packs of five available.
Please call or check our web site. For
current prices, contact us by mail
(info@mibac.com), phone (507) 645-
5851 or fax (507) 645-2377.

Does the site license version of
MUSIC LESSONS I work over a
network?
MUSIC LESSONS I was not written to be
a shared application where multiple
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students can use a single copy of the
program simultaneously from the server.
Progress Report scores can be saved to the
server. Our recommendation for site
license use is that you install a full copy
of MUSIC LESSONS I on the local hard
drive of each workstation. If the lab
workstations do not have local hard drives
then you will need to create multiple
copies of the program on the server and
check each copy out to a specific
workstation. Student records can be saved
to a common directory on the server.

Can I use MUSIC LESSONS I with a
guitar controller?
Yes. Go to the Guitar page of the
Preferences dialog and turn on “Guitar
Pitch (Down Octave).” See page 34. You
may need to set the MIDI Input Transpose
value, depending on the clef and on
screen instrument, to +12. See page 33.

Can I use MUSIC LESSONS I with a
wind controller?
Yes. If your wind controller is a transpos-
ing instrument you may need to set the
MIDI Input Transpose value. See page 33.

Can I use MUSIC LESSONS I with
an acoustic instrument or voice?
Yes. Pitch input devices convert sound to
a MIDI note that MUSIC LESSONS I can
use. See pages 95-96. MUSIC LESSONS
I contains a page for pitch input devices in
the Preferences dialog. See page 37-38.

Can I use the printer port with
MIDI?
Yes. However, we recommend you use the
modem port if possible. If you must use
the printer port, you can choose it on the
MIDI Setup page of the Preferences
dialog.

MiBAC MIDI Routines
Choose MiBAC MIDI Drivers and Printer
Port. See page 42.

OMS
Choose OMS. On the right side of the

dialog, click the OMS MIDI Setup button
and choose the printer port. See page 43.

MIDI Manager
Choose MIDI Manager. Click OK. Open
the PatchBay application and double click
the Apple MIDI Driver button. Another
window will open allowing you to choose
the printer port. See page 44.

I can’t get MIDI to work on my
PowerBook.
The problems we’ve encountered here
have been related to internal modems and
the AppleTalk setting. If your internal
modem is enabled, the modem port
connector on the back of the PowerBook
does not function. There is usually a
control panel, like PortShare, that can
enable and disable the internal modem.
You may need to experiment with the
AppleTalk setting in the Chooser. You’ll
have to restart to test changes. We have
routinely demonstrated MUSIC LES-
SONS I using MIDI on a Powerbook 520c
and a PowerBook G3, neither of which
has an internal modem.

MIDI works but the piano doesn’t
sound like a piano.
MUSIC LESSONS I sends a MIDI patch
change when you start the program, when
you switch drills, and when you switch
instruments. Choose Set MIDI Patches
from the sound menu. Click the Device
popup menu and choose your synthesizer.
If it’s not listed choose the Generic
device. Generic will show patches 1-128.
Make sure the check box Play On Click is
on. Click each patch in turn. When you
find the patch number for piano, click the
Permanent button. See page 33, 44.

Can I use QuickTime sounds with
my MIDI controller?
Yes. If you’re using MiBAC MIDI or
Apple’s MIDI Manager, you’ll need to
turn on QuickTime output on the MIDI
Setup page of the Preferences dialog.
OMS 2 can send MIDI output directly to
QuickTime. See page 33.
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IV. CREATING A HELP FILE
Files displayed in the MUSIC LESSONS
I Help window are TEXT files containing
colored styled text, pictures, and sound.
We’ve included the ML Help Editor
application so you can create your own
help files.

The ML Help Editor application is
initially located in the MUSIC LESSONS
I folder but can be anywhere. You can
freely mix text, pictures, and sounds in
help files. The ML Help Editor supports
drag and drop. You can copy or drag text,
pictures, and sounds from one window to
another, or from other applications to the
ML Help Editor window.

Text
Type text in the ML Help Editor. Use the
Font, Size, Style, and Color menus to set
the text attributes.

Pictures
Create pictures in a graphics program,
copy them to the clipboard or scrapbook,
and drag or paste them into the help file.

Sounds
You can copy and paste ‘snd ’ files into
the help file. See Creating Sound Effects
and Creating Instrument Sounds later in
this appendix.

Topics
Any text phrase using the bold underline
style will appear in the Topic List of the
Help window.

Experiment by making a copy of one of
the included help files and opening it in
the ML Help Editor. Make some changes
to the file, save it, and place it in the
MUSIC LESSONS I Help folder. Open
MUSIC LESSONS I and view the new
help file. All help files in the MUSIC
LESSONS I Help folder appear in the File
List of the MUSIC LESSONS I Help
window. See the User Guide, pages 21-22.

V. CREATING A
SYNTHESIZER PATCH LIST
Synthesizers organize their sounds
according to their MIDI patch number. On
synthesizers that don’t follow the General
MIDI standard, sound number one could
be assigned to anything the manufacturer
decided, piano, flute, or temple bells.
General MIDI specifies the exact sounds
assigned to patch numbers 1-128. Sound
number one on all General MIDI
synthesizers is a piano, sound number 33
is acoustic bass, etc. Your synthesizer
manual should list the instruments
assigned to patches 1-128 (or 0-127).
Type those names in a text file with one
instrument name per line. Here’s what the
patch name file for General MIDI looks
like.

For aesthetic reasons, limit names to
eleven characters in the Set MIDI Patches
dialog. Save the file with your synthesizer
name and place it in the Synthesizer
Name Files folder. It will appear in the
Device popup menu of the Set MIDI
Patches dialog.
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VI. CREATING SOUND
EFFECTS
If your Mac has sound input capabilities
you can record sounds to be used as sound
effects for right and wrong answers.
You’ll need additional software to record
sounds. The following programs work.

Let’s create a sound effect. We’ll use the
Sound Control Panel because it’s part of
System 7 and everyone has it. Other
sound recording programs have more
options and can create better recordings.
From the Apple menu, open the Sound
Control Panel. Make sure you’re on the
Alert Sounds page, and click the Add
button.

When the Record dialog opens, click the
Record button.

Say “good job” into the microphone and
click the Stop button. Click Save and
name the sound Good Job. Close the
Sound control panel. Open the System
Folder and double click System file icon.
When the System window opens you’ll
see a sound icon “Good Job.” You may
need to scroll to find it.

Hold the Option key down and drag the
Good Job icon to any other window. This
will copy the Good Job sound file to the
other window. Close the System window.
Place the copied Good Job sound file in
the Sound Effects folder in the MUSIC
LESSONS I 3 folder. Open MUSIC
LESSONS I and go to the Sound Effects
page of the Preferences dialog. Click the
Correct Answer radio button and then
select Good Job from the sound effect list.

Click OK. Then make sure Use Sound
Effects is checked in the Sound menu.
Answer a question correctly. You’ll hear
the new sound effect.
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VII. CREATING
INSTRUMENT SOUNDS
Make a backup copy of MUSIC LESSONS
I before attempting this.

If you’re technically inclined you can
replace the sounds we used for the piano
and guitar with your own. You’ll need
software to record the sounds. The
following programs work.

You’ll need resource copying software to
copy the sound resources into the MUSIC
LESSONS I application. The following
programs work.

Information on obtaining these programs
is given later.

Piano sounds are stored in six ‘snd ’
resources with IDs 1000-1005. All six
resources are the note C recorded in
different octaves. ID 1000 is the lowest
octave, ID 1005 is the highest. Record six
Cs at MIDI numbers 29, 41, 53, 65, 77
and 89, each approximately one second
long. Middle C is MIDI note number 60.
Save them as ‘snd ’ resources with IDs
1000-1005. Copy them into the MUSIC
LESSONS I application using Sound
Mover, ResEdit, or a similar program.

Guitar sounds are stored in six ‘snd ’
resources with IDs 1500-1505. Record the
six strings of the guitar at the fifth fret,
from bass to soprano, A-D-G-B-E-A, each
approximately one second long. Save
them as ‘snd ’ resources with IDs 1500-
1505. Copy them into the MUSIC
LESSONS I application using Sound
Mover, ResEdit, or a similar program.

VIII. THIRD PARTY
SOFTWARE
Apple Computer
QuickTime

Apple Computer, Inc.
1 Infinite Loop

Cupertino, CA 95014
408-996-1010

Coda Music Technology
Vivace

Coda Music Technology
6210 Bury Drive

Eden Prairie MN 55346
(800) 843-2066
http://www.codamusic.com/

Macromedia
Sound Edit 16, Deck II

Macromedia, Incorporated

600 Townsend Street
San Francisco, California 94103
(415) 252-2000

http://www.macromedia.com/
Pyware
Amadeus

P.O. Box 399
Argyle, Texas 76226
Sales: (800) 222-7536

http://www.pyware.com/
Wildcat Canyon Software
Autoscore

Wildcat Canyon Software
1563 Solano Avenue, #264
Berkeley, CA 94707

(800) 336-0989 General Information
http://www.wildcat.com/
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IX. INTERNET RESOURCES

MiBAC Music Software
http://www.mibac.com
email: info@mibac.com

techsupport: tech@mibac.com

Apple Computer
QuickTime

http://www.quicktime.apple.com/
MIDI Manager

http://asu.info.apple.com/swupdates.nsf/
artnum/n10660

Opcode Music Systems
OMS (Open Music System )

http://www.opcode.com/downloads/

MIDI / Music information
www.harmonycentral.com

www.midifarm.com

X. TECHNICAL
INFORMATION
MUSIC LESSONS I was written in C++
using the Metrowerks CodeWarrior C++
compiler, the PowerPlant application
frameworks, and the C++ Standard
Template Library.

The following internet programming
resources were incorporated into the
program.

The WASTE text engine was used for
displaying text in progress reports and
help windows. WASTE text engine ©
1993-1996 Marco Piovanelli.

CWASTEEdit, a Power Plant Wrapper
class for WASTE © 1994-1996 Timothy
Paustian.

The color popup menus used in the
Preferences dialog use Color MDEF by
Jordan Zimmerman. © 1995 All rights
reserved worldwide.
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